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•ABOUT IRON ASSIST•

The IRON BRIGADEIRON BRIGADE assist program helps participants with the details of playing an American Civil War miniature
wargame.  I designed the IRON BRIGADEIRON BRIGADE assist program well after the IRON BRIGADEIRON BRIGADE miniature rules were
written.  I did not change the rules to make writing the assist program easier.  Instead
much effort was made in development of the assist program to enhance play of the game.
The assist program is not a computer game, nor is it intended to be.  It is merely an auto-
matic assistant, which helps the players with handling some aspects of the game.  I have
added some features that allow players to change some characteristics of weapons. The
operator can also intervene, if necessary, in the outcome of combat.  This allows players
who disagree with some rules, to alter them to their liking.

Players and referees should read this entire manual and the IRON BRIGADEIRON BRIGADE rule book, before playing a scenario
using the IRON BRIGADEIRON BRIGADE assist program.  It is the intention of this computer assist program to make wargaming
more fun.  I hope I have succeeded.

Happy gaming.

Mike Willegal March 1994

I have taken every effort possible to ensure that this product is of the highest quality, but sometimes problems slip past
the testing process.  Should you happen to encounter a problem, I will be happy to help.  Just write.

snail mail:
Mike Willegal
849 Livingston St.
Tewksbury, MA 01876

email:
mike@willegal.net

web:
http:willegal.net/home.htm
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• SETTING UP A GAME WITH IRON ASSIST •

The most difficult part of using the IRON ASSIST IRON ASSIST program is setting it up.  Take the following steps to set up a
game.

a. Select the name of the database.

b. Create the units and weapons.

c. Initialize the data base.

Setting up a scenario is documented in this chapter.

IRON ASSIST IRON ASSIST comes with an example scenario named New Market that corresponds to the sample scenario de-
scribed in the IRON BRIGADE IRON BRIGADE  rule booklet.  To skip the setup process,  just open "New Market," set the side to CS
and execute.

Disk And Memory Requirements

IRON ASSISTIRON ASSIST does not require much disk or memory space.  Just be sure there is at least 20K of free disk space and
1 MB of free memory available before starting IRON ASSISTIRON ASSIST.
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The IRON Database

A sophisticated data base manager is built into the IRON ASSIST IRON ASSIST program.  A scenario must be entered into this
database in order to play.  The database contains two parts.  The data part and the index part.  Each part is represented on
your computer screen as an IRON ASSIST IRON ASSIST database file.  The files will have the same name with the exception that
the index file will contain the suffix [.ndx].

These two document files cannot be read by other applications and must be kept together in the same folder.   Renaming
these files is OK, if both files of the database are given exactly the same name (with the index portion maintaining the
suffix [.ndx]).  When opening or saving databases, use either name.  IRON ASSIST IRON ASSIST will understand either name
when opening or saving files.  If IRON ASSIST IRON ASSIST is launched by double-clicking on an existing data base icon, that
data base is opened.

Example:

new market - data portion of the database

new market.ndx - index portion of the database

Launching IRON ASSIST IRON ASSIST by double-clicking on the IRON ASSIST IRON ASSIST icon causes an empty data base to be opened.
The name of this database is displayed as the title of the IRON ASSIST IRON ASSIST log window.  It is in the form of untitled#,
where # is the lowest number available that has not been previously used.

To learn the current database name, just check the title of the IRON ASSIST IRON ASSIST log window.  It always displays the
current data base name.



666

The File Menu

New
Create a new scenario with this menu item.  The program will create and open a new data
base with no entries.  The name of the data base will be untitled#, where # is the lowest
number available that has not been previously used.  For example, if untitled0 and untitled1
exist, new will create an empty data base called untitled2.  The current scenario will
automatically be saved before the new one is created and opened.  After creating a new data
base, unit records must be created for each side before the program can be used.

Open
'Open' will open an existing scenario.  From the dialog, select the database file to be opened.
The current scenario will be saved automatically before opening the new scenario.

Save
'Save' will flush any cached data from the currently open scenario to disk.   This should be executed periodically during a
game, to prevent loss of data in case of the computer crashing. It is recommended that the system cache is turned off
when running IRON ASSIST IRON ASSIST .  The database incorporated into IRON ASSIST IRON ASSIST has a built in cache and system
cache will not enhance performance.  However it will leave the system more vulnerable to problems when recovering
from crashes.

Save as
'Save as' allows the user to save the current scenario under a new name.
After selecting 'Save as', the user will be presented with a dialog box with
the current scenario name highlighted.   Enter the name to save the current
scenario as and then click the mouse on the 'Save' button.  The scenario
will then be copied to the scenario with the new name.  The old scenario
will be closed and IRON ASSIST IRON ASSIST will now work with the newly created
scenario.  If a name is selected that is already present, IRON ASSISTIRON ASSIST
will give you the option of aborting the save or overwriting the existing
database.  If the currently opened scenario name is selected, it will simply

flush any cached data from the current scenario to disk  It will not delete the current data base.Holding down the option
key when selecting the 'Saveas' menu item will cause a special kind of save to take place.  Any melee and fire records in
the current scenario will not be saved into the scenario specified by the new name.

Preferences
These options allow you to change some characteristics of the assist
program.  Options are assigned to the data base that is currently active.
New data bases always default to no options set.  All options are active
when checked.

a. Limited Ammo - When checked, this option turns on two features of
the assist program.  First the program decrements the amount of ammuni-
tion available to a unit every time the unit fires.  Secondly, the program
prevents the unit from firing when ammunition is depleted.

b. Regional Differences - When checked, this option adds one to the rally
rating of Union units.  When this option is used, Union units should be set up with an initial morale of one less than
normal.

c. Weapon Failures -  This option enables the possibility of a unit suffering losses from the failure of the weapons it
carries.  When a unit fires and has a possibility of failure 18 or 17/18, a check is made to see if the unit suffered from
weapon failures.
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d. Regimental Command - When this box is checked, the regimental command rules are implemented.  This affects two
areas of the game.  When a unit suffers more than two levels of morale loss, a check is made to see if the regimental
command is destroyed.  The other area is in rallying, where adjustments are made, if the regimental command has been
destroyed

e. Smooth Range Steps - When this box is checked, the effect of a weapon at different ranges is smoothed.  The effect of
a weapon will smoothly transition from point blank to long range without any noticeable jumps from one range to the
next.

f. Variable Combat - When this slider is moved off zero, the effects of combat are randomized.  For instance:  With the
slider on 20, a combat with a non-random result of 100 casualties, could vary from 80 to 120 casualties.  Note that
variable combat is not affected by any number entered into the text box.  Use the slider to change this value.

Quit
Use this menu item to exit the IRON ASSIST IRON ASSIST program.  The current data base will be automatically saved and closed
before exiting.

If you exit the IRON ASSIST IRON ASSIST program after creating a new data base that has not been saved, you will be given the
option of saving or deleting the data base before exiting.  Choose cancel if you wish to delete the new data base.  Enter
the program name and click on the 'Save' button to save the new data base.  If you click on the 'Save' button without
changing the data base name, you will be asked if you wish to replace the existing file.  Respond with yes to save your
data base with the existing name.  See the 'Save as' menu item documentation for more information on saving files before
quitting.

The Edit Menu

The edit menu is not functional for this release of IRON ASSISTIRON ASSIST.

The Window Menu

Selecting either item from this menu will either show or hide a window showing the army status
for a given side.

This status includes statistics for an entire army.  This includes the starting size
of the army, number casualties and percent casualties.  Average starting morale
and current morale are also calculated and displayed.  These values are kept
current for as long as the window is kept open.

Although this information does not have any specific impact on the game, it
could be used to determine victory conditions in a given scenario.  In other
words, the game could be declared a victory when an army loses a certain
percent casualties, or its average morale drops to a certain level.
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The Organization Menu

New Unit
The 'New Unit' menu item enables creation of new units for the currently selected
side.  Use the controls to select the initial unit size, morale, weapon, regimental
number, name and type.  Then type return or click on the 'Accept' button to enter the
unit into data base.  Click on 'Cancel' to exit this dialog.

a. Pop-up menus are used to select
the unit's name, type, weapon and
initial morale.  Click and hold
down the mouse button on the item
to bring the menu up.  Select the
value by moving the mouse to the
desired value.

You will notice the 'Define Name' items for the unit name and
type pop up menus.  Selecting this entry allows specification of a
new name that will subsequently be added to that pop-up menu.

b. Edit text boxes with arrows are used to change the unit's ID
number and initial size.  Just use the tab key or the mouse to select the number to be changed and enter the new value.
An alternate method is to click in the arrow keys to increase or decrease the current value.  Holding the command key
down while you click will cause the value to be changed by increments of ten.  Hold the command and option keys both
down to change the value by increments of 100 or hold the command, option and shift keys all down to change the value
by increments of 1000.

Your new unit will not be accepted if there is a unit already existing by that name.  A beep will sound if the program
cannot add the unit to the data base.  Once you have entered a new unit, use the modify menu selection to modify the
characteristics or delete existing units.

Modify Unit
Selecting this menu item enables you to view, modify or delete an existing unit record.    Use the pop-up menu under the
unit name or the next/previous buttons to select the desired unit.  Only records for the currently selected side can be
selected.

You can modify all changeable unit parameters in this dialog.  There are four different classes of parameters with
different modes of selections for each.

a. Pop-up menus are used to change the unit's weapon,  formation, current and initial morale.  Click and hold down the
mouse button on the item to bring the menu up.  Select the value by moving the mouse to the desired value.

b. Edit text with arrows can be used to change the unit's initial size, current size, ammo and range settings.  Just use the
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tab key or the mouse to select the item to be changed and enter the new value.  Click in the arrow keys to increase or
decrease the current value.  Holding the command key down while you click will cause the value to be changed by
increments of ten.  Hold the command and option keys both down to change the value by increments of 100 or hold the
command, option and shift keys all down to change the value by increments of 1000.

c. Radio buttons are used to change the unit's commander, number of ranks deep,  weapon failure possibility and
protection.  Click the mouse button in the appropriate item's circle to change setting.

d. Check boxes are used to toggle the unit's in-play, prone, split move, regimental command and artillery acquired fire

settings.  Click the mouse button in the appropriate item's box to toggle the setting.  If the unit's in-play box is not set, the
unit will not be show in any menus or dialogs while executing the sequence of play.  Therefore, the unit is out of play.

The 'Delete' button will delete the currently displayed unit from the data base.

The 'Accept' button will make the changes to the data base permanent.  Changing the selected unit or quitting the modify
dialog before clicking on the Accept button will cause changes to the unit to be discarded.  The Cancel button will close
the modify dialog.

This dialog can be used to adjust unit parameters outside the constraints of the program.  This could be for optional rules,
or to correct a mistake in play.
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Split Unit
You can split units into two or more separate units with this menu item.  Each new unit will take on all of the characteris-
tics of the parent unit.

Perform the following steps to split a unit into one or more parts.

a. Select the parent unit with the 'Select >>' pop-up menu.

b. Set a percentage of the parent unit's strength with the 'Percent to split' edit text item.  This is the percent of parent that
will join the new unit.

c. Click on the 'Add' button.  The name of the new unit and its size will be displayed in the list at the top of the dialog.
Cancel this choice by clicking on the unit name in the list box.  Then click on the 'Remove' button and the unit will be
removed from the list.

d.  Repeat steps' b and c, until all the new units are listed at the top-center of the dialog.

e.  Click on the 'Split' button and the IRON ASSIST IRON ASSIST program will create the desired new units.   The parent unit will
be reduced in size accordingly.

Click on the 'Cancel' button when done with this dialog.

Init Data Base
'Init Data Base' menu item resets all units back to initial default settings.  You should only initialize the data base before
a game.  Initializing the data base while a game is in progress will result in a reset of the game back to initial conditions.
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Join Unit
Combine two or more units into one unit with this menu item.  The newly formed unit takes on several characteristics of
each unit being joined.

• The lowest morale of any unit being joined.
• Average ammunition supply.
• The weapons of the destination unit.  However, if one or more of the other units, had a possibility of weapon failures,
the new unit will inherit this possibility.
• The best regimental command and officer characteristics of any unit being joined.

Do the following steps to join multiple units into one.

a. Select the destination unit with the 'Dest >>' pop-up menu.

b. Select a unit to join with the destination unit.  Choose the unit with the 'Select>>' pop-up menu.

c. Click on the 'Add' button.  The name of the unit will be displayed in the list at the top of the dialog.  Cancel this choice
by clicking on the unit name in the list box.  Then click on the 'Remove' button and the unit will be removed from the
list.

d. Repeat steps' b and c, until all units to be joined to the destination unit are listed at the top-center of the dialog.

e. Click on the 'Join' button and the IRON ASSIST IRON ASSIST program will join the listed units to the destination unit.

Click on the 'Cancel' button when done with this dialog
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Weapons Editor
Alter the effects of weapons and define new weapon types using the weapons editor.  Any changes made will only be
reflected in current data base.

To alter a weapon's effect.

a. Select the weapon using the 'Weapon' pop up menu.

b. Change the default ammunition supply by entering a new number in the 'Default ammo supply' edit text item.

c. Alter the weapon's effect table by changing the values in the 'Range' and 'Effect' edit text items.  Note that ranges must
be entered in a shorter to longer order.  Zero must be entered in the box to the right of the longest range.

d. Click on the 'Save' button to make changes permanent.

Create a new weapon by clicking on the 'New' button.  This will bring up a dialog that will allow definition of the new
weapon's name.  After the name is defined, the weapon effects may be edited as with any other weapon.

Click on the 'Done' button to exit the weapon editor

The Side Menu

Change which side is the active side by selecting the desired side's menu item.  Only units of the active
side may be created or edited.  The active side is the side that is currently performing morale checks,
moving and firing.

The Play Menu

Bring up the phase window with this menu.  The actual game is played through an interface
with the phase window.  Using IRON ASSIST IRON ASSIST to help you play the game is described in
the next chapter.
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• USING THE ASSIST PROGRAM •

The Phase Window

The players start the game by selecting the execute item of the play menu.  This causes the IRON ASSIST IRON ASSIST program to
open the phase window.  Control the game with this window.

The players normally go through each phase of each turn.  This is done by clicking on the 'Next Phase' button of the
phase window.  Then the program will select the next phase of the sequence of play.  If the new phase is the meleé
phase, the active side is automatically changed.  The active side is represented by the battle flag icon in the phase
window.

If any actions are appropriate or possible for that phase, the program brings up the dialog for that phase.  If actions are
not possible in a given phase, no dialog will appear.  An example would be a rally phase at a time when the active side
has all units at maximum morale.  There are no units to rally, so the rally dialog is not brought up.

Players may also click directly on a phase name to activate it. Players may click directly on the battle flag icon to change
active sides.  Players may activate the current phase by clicking on the 'Execute' button.  Clicking on the 'Cancel' button
will close the phase window.
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Meleé Phase

This is the meleé dialog.

a. Use the 'Friendly' pop-up menu to select the phasing player's unit in contact with the enemy.

b.  Select the En masse check box, if the  friendly unit is in En masse formation.

c. Select an enemy unit in contact with this unit with the 'Enemy' pop up menu.

d. Enter the percent of the enemy unit in meleé contact with the friendly unit.  Refer to the IRON BRIGADEIRON BRIGADE rules for
the precise rules about percent in contact.

e. Click on the 'Add' button to add this unit to the list in meleé contact with this friendly unit.  You can also remove
enemy units from this list.  Just click on the unit name in the list box and then click on the 'Remove' button.

f. Repeat steps c - e, until all enemy units are entered into the list.

f. Click on the 'Meleé' button to execute the meleé.

These lists of units in meleé are maintained in the IRON ASSIST IRON ASSIST data base from turn to turn.  When it is the other
side's turn to meleé, use to 'Auto' button to find the enemy units in contact, automatically.

Use the 'Cancel' button to exit from the melee dialog

.
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Rally Phase

This item in the sequence of play item is handled automatically by the computer.  Each unit below maximum morale
level will be displayed in turn in the Rally dialog.  If no  dialog is displayed when this phase is executed, there are no
units below maximum morale.

Just click on the current command personality, if different from that displayed.  Then type Return or click on the 'Rally'
button.  A beep will sound, if the unit regains one morale level.  The unit's status will also be printed out on the log
window.

After logging unit status, the computer will display the next unit to rally.  If there are no more units to rally, the program
will exit from this dialog.  If a unit rallies from level two (pinned) to three (disorganized), the dialog will remind you that
the unit is not allowed to move that turn.

Use the 'Cancel' button to exit from this dialog without rallying.
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Retreat Phase

The retreat phase is handled automatically by the computer.

The name of each unit retreating or routing will be displayed in a dialog
box.  You will be instructed to retreat or rout each unit in turn.

After all units are retreated or routed you will be asked to select each non
broken unit in sight of each of these units.

a. Use the 'Unit' pop up menu (or Next and Previous buttons) to select a unit in sight of the broken or routed unit.  Select
the En masse check box, if this  unit is in En masse formation.

b. Click on the 'This Unit' button.  This causes the morale check to take place.

c. Repeat a and b for each unit witnessing the retreating unit.

d. When no more units can be selected, click on the 'Cancel' button.

Use the 'Cancel' button to close the panic dialog.  A new panic dialog will reappear for each routed or broken unit.

Note that the rules specify that units only lose morale during the first turn that they see a unit retreating.  Select each unit
in sight of a retreating unit, only on the first turn it is in sight.

Double Quick Phase

Select any units to be moved during the double quick phase.  The computer will automatically adjust morale for these
units downward two levels.  The computer will only allow selection of those units with morale levels high enough to be
moved during the double quick phase.

Use the 'Cancel' button to exit from the double quick dialog.
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Move and Fire Phase

Movement must be handled by the players.  Fire takes place during this phase in the fire dialog.

a. Use the 'Firing' pop-up menu to select the unit that is to fire.

b. Select the target with the 'Target' pop-up menu.

c. Select the target protection and ranks deep by clicking on the appropriate radio button.  If the target is in En masse
formation, select the En masse  fomration check box.  If the firing unit should get the bonus for firing with the red tables,

check the red table box.  Select the mounted or unmounted officer if there is a mounted or unmounted officer present
with the target unit.  If there are both mounted and unmounted officers with the unit, select the mounted officer.  Select
prone unit firing, if the unit firing is prone and is equipped with muzzle loaders.  Select split movement or acquired fire if
that is appropriate.  Enter the range or use the arrows to adjust it.  If only part of the unit is firing at that target, enter the
percent in the 'Split Fire' dialog item.

d. Click on the 'Add' button to add this unit to the list of units about to fire.  You can also remove firing units from this
list.  Just click on the unit name in the list box and then click on the 'Remove' button.

e. Repeat steps b - d until all firing units are entered into the list.

f. Click on the 'Fire' button to shoot.   The system beep will sound once for each morale level lost.  Casualties and morale
losses are displayed in the log window.

Fire combat  uses a special fire record to save information related to a specific unit firing at a specific enemy. As you
make changes in the fire dialog, this fire record is updated.  When several units are listed as firing at one target, each unit
may have unique fire parameters.  Select the specific firing and target units to view and modify the firing parameters.

These fire records are maintained in the IRON ASSIST IRON ASSIST data base from turn to turn.  When it is the other side's turn to
fire, use to 'Auto' button to automatically find the enemy units firing on the selected friendly unit.  Range changes will be
updated automatically in both firer and target fire records

If only one unit is firing, there is no need to add it to the firing list.  Just adjust firing parameters and click in the 'Fire'
button.  That will cause the fire to take place and the parameters entered will be saved in a fire record for future turns.

Use the 'Cancel' button to exit from the fire dialog.
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• OTHER OPTIONS AND NOTES •

Recovery From Crash

Should your computer crash for any reason while running IRON ASSIST IRON ASSIST you may lose the open database.  When
IRON ASSIST IRON ASSIST tries to open this database, you may get a message warning about a corrupted data base.  This is a
warning only and does not, in any way, indicate whether the data base is good or bad.

In any case the user should keep backup copies of all files and programs and periodically use the save command while a
game is in progress.

This version of IRON ASSIST IRON ASSIST is not compatible with data bases created by previous versions of IRON ASSIST IRON ASSIST .

IRON ASSIST IRON ASSIST may hang while trying to open or access a damaged database.  Remember that IRON ASSISTIRON ASSIST
automatically opens untitled0 upon launching.  If you  have trouble starting IRON ASSIST IRON ASSIST , drag untitled0 and
untitled0.ndx into the trash and empty it.  Then attempt to launch IRON ASSIST IRON ASSIST .

IRON ASSIST IRON ASSIST will not function properly with empty databases.  You must create units for each side in the database
before attempting to play.

Databases can only be deleted by dragging the icons on the desktop into the trash.  Be sure you empty the trash before
using the same database name with IRON ASSISTIRON ASSIST.
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The Log Window

The IRON ASSISTIRON ASSIST program logs
unit strength, and morale, both current
and initial.  This occurs whenever the
unit's record is written to the database.
Also some other events will be logged
in this window as they occur.  The log
window can be moved, resized and
scrolled like any standard Macintosh

window.  The depth of the log is limited in depth to about 32,000 characters.  After this many characters are printed into
the log window, a line of the oldest data will be deleted to make room for new output.  There is no way to save the log
between sessions or print it during a session (other than by doing a screen snapshot).

Castings and Casualties

One difference between manually playing IRON BRIGADEIRON BRIGADE and using the IRON ASSIST IRON ASSIST program is handling of
casualties.  Manual play handles casualties in terms of castings.  IRON ASSIST IRON ASSIST deals with individual soldiers.
Players should check occasionally to see if stands should be removed from play.  This can be done by scanning the log
window to see how many castings remain in a unit.  When the number of remaining stands exceeds the number  required
to hold the remaining castings, remove the excess stands.

The New Market Historical Scenario

The IRON BRIGADEIRON BRIGADEassist program comes with a preset database to represent the Battle of New Market.  The
scenario in the program uses actual unit sizes (when known).  The IRON BRIGADE IRON BRIGADE rules booklet has changed unit
sizes to fit the number of castings that would be most commonly available with wargame regiments.  Use the map and
order of battle in the miniature rules book to complete setup of this scenario.
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The Gainsville Scenario

Use the following map to set up the tabletop battle field.  Confederate moves first.

Confederate gets 3 officers, Taliaferro, Ewell and Jackson.  Rate Taliaferro and Ewell poor and Jackson average.
Federals get 2 officers, Gibbon who is rated good and Doubleday who is rated average.

Note that the poor ratings of the Confederate forces are assigned to reflect the poor tactics used by them during this fight.
Historically the battle was ended by darkness with the Federals holding a defensive position along the ridge into the
woods.  Limit the game to 15 turns.

Taliaferro’s Division

Gibbon’s Brigade
in column along road

6 WI
2 WI

 7 WI
19 IND

Batt. B, 4th US

56 PENN76 NY

Doubleday’s Brigade
in column along road

WOODS

WOODS

ORCHARD
RAIL FENCE

RIDGE

Taliaferro’s Brigade
47 ALA
48 ALA
10 VA
23 VA
37 VA

Baylor’s Brigade
2 VA
4 VA
5 VA
27 VA
33 VA

Starke’s Brigade
1 LA
2 LA
9 LA
10 LA
15 LA

Trimble’s Brigade
15 ALA
12 GA
21 GA
21 NC
1 NC battalion

Lawton’s Brigade
13 GA
26 GA
31 GA
38 GA
60 GA
61 GA

Ewell’s Division

Jackson’s Corp - in battle line along edge of woods

Pelhan Progue Wooding Carpenter Balthis


